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Download resources from below link.
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3 17uk2bmtglLQV?usp=sharing

Open “QGIS Desktop 2.8.1”. Go to

v QY AR SRl ST VRARAIL (Byoragers

And select “us.tmax_nohads_Il_201405_float.tif” and open it.
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Project Edit View | Layer | Setfings Plugins
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shortest path 7 Browser

- x
Vector Raster Database Web Processing Help
=l B0 QDee- N e EEs-0ns EH B - =
Add Layer P\ AddVectorLayer... Cirl4+shift+v _'rl it 'rl 3 E-._ I
Embed Layers and Groups... ¥, AddRaster Layer... CtrlShift iR i -
Add from Layer Definition File... W, add Postels Layers... Ctrl+shift+D
Copy style /% Add Spatialite Layer... Cirl+Shift+.
R B AddMSSQL Spatil Layer... Corlshift+
@, Add Orade Spatial Layer... Ctrl+Shift+0
Ee AN LT @ Add WMSMWMTS Layer... Crl+shift+w
o EIREEIT ®, Add Orade GeoRaster Layer...
| savelayer Edits @ AddWCS Layer.
#  curentEdis .
Save As... 95 Add Delimited Text Layer... LA = |:|'=I
Save As Layer Definition File... - _r et = P
cul+p
Set Scale Visibity of Layer(s)
Set GRS of Layer(s) Cul4shift+C
Set Project CRS fiom Layer
Properties...
Query. Cirl+F
Labeling
Add to Overview
Add All to Overview
©2 Remove Allfrom Overview ILhLr A |:r=|
B B e
% Show AllLayers Cul4shiftsu : -
< Hide AllLayers Cirl4Shift+H
®  show Selected Layers
- Hide Selected Layers
Coordinate: | -1.699,0.679 | scale [1:1,508,881 | Rotation: 0.0 [2] B4 Render @Ess 43 @
to search 4

H O Type here

TV NGWARE cdf view Taster image data by diicking b'n"‘l-dentﬁ" ?éatdbé" buttona

just click on random places in raster layer. In identify result window it will
display the data for that particular pixel.

.-.lF-.l_:lEI'

B B
¥

r

itvoyagerLiFeit

-l W R R e
) '

tvoyager

Tk

r R
)

-

oY ager

BEErs

YaEers.

In itvoyager

in I-'.'EJEE'EI'E

In itvoyager

c.in itvoyager

.in itvoyage:

c.in itvoyager

.
™ i
Li Ly
-r-—-rE
I

.
™ i
Li Ly
-r-—-rE
I

i

i

r

r

nd

50N ITVOYager


http://itvoyagers.in/
https://drive.google.com/drive/folders/1B_TJDH1hnnCXNukcy-3_17uk2bmtqLQV?usp=sharing
https://drive.google.com/drive/folders/1B_TJDH1hnnCXNukcy-3_17uk2bmtqLQV?usp=sharing

ITVoyagers (itvoyagers.in)
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L N

5 - ) e e [T g e

B R 108 [ (%

Vo Layers & X
O @ = TEE L
:..D ~ [ [ ustmax nohads Il 20140525 float
L] o
= 319471
Ve
ﬁ% Identify Results n
® 3IE @3
Shortest path 8 x
L veu
Start us. tmax_nohads_Il_201405...
‘ | BE  us.tmax_nohads
Band 1 28, 708221435546875
Stop (Derived)
\ | [
Criterion Length -
Length | |
Time [ |
Calcuiate Export Clear
— Mode |Current layer [ Auto open form
3 {Heb
view [Tee = Help
¥ Shortestpath | Browser

¥ coordinate: | -102.55,17.74 | scale [517,776,445 ] Rotaton: [0.0 t Mrender @ epsciaizs @

Now add “2013_Gaz_ua_national.txt” file. For that go to
Layer> Add Layer > Add Delimited Text Layer...

Browse “2013..Gaz_ua_national.txt” file and perform following changes.

£ QGIS 2.8.1-Wien - X
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

) E Create Layer » [ﬁ (;"’- L\ JeWeN - MH ; § o - e 8 8 [T - I:l “v&?
Add Layer » L Addvector Layer.. crisshift+v |
Embed Layers and Groups... B AddRaster Layer... Ctri+5hift+R I
B (0% Add from Layer Definition Fie... @, Add PostGIS Layers... Cirl+Shift+D |
oyers G /%, Add Spatialite Layer. Cirl+Shift 41
\f: = 3 e BB ddMssQL Spatil Layer... Ctrl+shift+41
:-l " § @, Add Crade Spatial Layer... Ctrl+Shift+0
o |[vEl e Open Attribute Table @ cdWMSIMTS Layes J——
mo 2 :mgg\e g &, Add Oracle GeoRaster Layer...
ﬁs j“ .EL“'E‘ Ei &) AddwesLayer..
Current Edits W) Add WS Layer..
)j% Save As... 9., Add Delimited Text Layer. ..
Q, Save As Layer Definition File:
E;E‘ Shortestpath | | Remove Laver/Group 4o
Start Duplicate Layer(s)
|: Set Scale Visibility of Layer(s)
Stop SetCRS of Layer(s) Ctrl+shift+C
| Set Project CRS from Layer

Properties...

Criterion
Query... crl4F

et [ g
Time: .

S Add to Overview
Calaiate oo

Add All to Overview

2 Remove All from Overview

Show AllLayers Ctrl+shift+U
& Hide All Layers Ctrl4+shift+H
Show Selected Layers

Hide Selected Layers

3y Shortest path T BrOWEEr ]

| coordinate: | -118.79,55.81 | scale [:17,776,445 ~| Rotaton: [0.0

2 ARender @ Ersciasze @
45

ﬂ O Type here to search a i B ¥ B a0y ’ =

Select “Custom delimiters”, check “Tab” checkbox and select “INTPTLONG” &
“INTPTLAT” in “X field” & “Y field” respectively. Then click on “OK".
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Layers RS

V; 8 = @G O
:'.o ¥ ustmax nohads Il 20140525 float
0
mﬁ‘ 318471
Ve
q] shortest path F x
£= | Start
o || | BE
2
& | | B
90 Criterion Length -
Y - Length | |
g | Tme [ ]
u
Caleulate Export Clear
3 Help
Iz}
\=
¥ Shartest path Browser
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D @ ~ | (@ - £
sl et >4 @
o =3 g, ol W | e g
4 Create 2 Layer from a2 Delimited Text File 7 X
File Name \E:ﬁayvasvaiqelsfajbfzu 13_Gaz_ua_national. txt Browse...
Layer name 2013 Gaz_ua_national | Encoding |uTF-8 -

File format

Record options

Field options

Geometry definition (®) Point coordinates

() Regular expression delimiter

[] colon

| quote |- | Escape

() €5V (comma separated values) |@) Custom delimiters

[] comma Tab [] space
Gther delimiters |

Number of header lines to discard
[ Trim fields ] Discard empty fields [] Decimal separator is comma
(O Well known text (WKT)

[] semicolon

First record has field names

() No geometry (attribute only table)

X field Y field ] bMS coordinates

Layer settings Use spatial index [JUse subsetindex [ watch file

GEOID NAME UATYPE  ALAND ~AWATER ALAND_SQMI ~AWATER_SQMI INTPTLAT A~
1 00037 Abbeville, LA Urban Cluster € 29220236 300497 11283 0116 29.967224 -
2 00064 Abbevile, SCUrban Cluster  C 11279155 19786 4.355 0.008 34.179237 -
3 00091 Abbotsford, WI Urban Cluster C 5363428 13221 2,071 0,005 44.948612 -
4 00118 Aberdeen, MS Urban Cluster C 7416537 52820 2864 0,020 33.824742 -
5 00145 Aberdeen, SD Urban Cluster  C 33124147 120864 12,789 0.047 45.463186 -
& oz Aberdeen, WA Urban Cluster C 39997945 1929686 15.443 0745 .976%5 - "

Cancd Help

Select “EPSG:4326" in

¥ coordinate: | -118.79,55.81 | scale [:17,776,445 | Rotation: ‘

CRS selector window.

Render (D EPSG:435 @

 Coordinate Reference System Selector 7 X b - B %?
|| Specify CRS for layer 2013_Gaz_ua_national
& (@
Layers .
Filter | | Browse...
ﬁﬂ =~ T Encodi UTF-8 -
Recently used coordinate reference systems TN
v b -
g | erdinate Reference System Authority 1D ~ () Regular expression delimiter
31,94/ /GB 1936 / British National Grid EPSG:27700 [ colon [ semicolon
rth_America_Albers_Equal_Area_Conic EPSG:102008 | Escape [*
o/ UTM zone 34N EPSG:3095 I
S 84 / Pseudo Mercator EPSG:3857 has field names
rld_Azimuthal_Equidistant EPSG:54032 B o
584 EPSG:4326
v | bkm) () No geometry (attribute only table)
Shortest path < >
~  [] DMS coordinates
Start Coordinate reference systems of the world Hide deprecated CRSs
— . e e
~
o Coordinate Reference System Authority ID BLAND SOMI | AWATER SQMI | INTPTLAT | A
P 7 3
Voirol 1879 (Paris) EPSG:4821 b oms o116 og.067224] |
WGS 66 EPSG:4760
e WGS 72 EPSG:4322 i 0008 HAPZ7 | -
riterion
WGS 72BE EPSG:4324 2om 0.005 +4.548612| -
Length WG5 84 EPSG:4326 2864 0.020 33.824742 -
7. WGST. v :
e[ . WGS72 IGNF:WGS72G N 12788 0.047 45.463186
15.443 0.745 46.976365 - ¥
Caleulate | selected CRS: [wes 84 | >
+proj=longlat +datum=WGS84 +no_defs
[+3 Cancel Help

¥ shortestpath  Browser

Cancel rep

| coordinate: -118.79,55.81

Now add “Point sampling tool” plugin.

3|Pgge
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AP0 L&

csw

Layers & x |

£ Plugins | Al (724)

-
ﬁ Installed

Mot installed

M

Shortest path

& Upgradeable
Start

Criterion

Length

- Tme |

Caloulate Clear

BN DD DV

Expart

S Ztelp

P b

e

Shortestpath  Browser

<

Search [point s

opeMoise

oint sampiing tool
pointshifter

Processing PS Tools provider

Point sampling tool

Samples polygon attributes and raster
values from multiple layers at specified
sampling points

The Point Sampling Tool Plugin collects polygon
attributes and raster values from multiple layers
at specified sampling peints. You need a point
|ayer with locations of sampling points and at
least one polygon or raster layer to probe values
from. The plugin creates a new point layer with
locations given by the sampling paints and
attributes taken from all the underlying polygons
orfand raster cells. Please use Control and Shift
keys in order to select multiple columns and
bands. Note this tool is not compatible with
mulitipoint sources, unless each multipoint
contains exactly one point. Using multipoint
samples that contain more points in multipoints
may produce unreliable results.

103 rating vote(s), 185207 downloz ,,
>

Install plugin

<

Upgrade al

Ol Install, reinstall or uparade the selected plugn |

H O Type here to search

| coordinate: |

-0.966,0.989

| scale [1:1,508,881 | Rotaton: [0.0 FRender @ EPsc:a32s @

Once plugin is installed go to.

Plugins > Analyses > Point sampling tool

£ QGIS 2.8.1-Wien

T- Hl %?

Project Edit View Layer Settngs | Plugns | Vector Raster Datsbase Web Processing  Help
™ ENE ELEE b M d Install Pl (0 (= |
. % Manage and Install Plugins.... ( ” o
0 q faba e
- @, Python Console ctrl+ak+? e sl Q
7] >
] B [I® \/g % Analyses * £ Paintsamping tool
GRASS v r—/

Ve Layers o J

o © ¥ @ @ L} °

Fu © 2013 Gaz ua national

17 B ustmax_nohads_Il_20140525_float

a 0

/;D’ 319471

% Shortest path 8 x

@ Start

\ | [

R W

&g || | P

, Criterion Length -

¢}
§7° . tenatn [ ]

g | Tme [ |

I}

Calulate Export Clear

. 5

== 5% telp

:{

=]

o

¥ Shortestpath  Browser

g

H O Type here to search

Now we have to select the few attributes, we are selecting GOID, NAME and

Band 1.

Give output file name and path by clicking on “Browse”. Then click on “OK”.
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W ® e M

£ Point Sampling Teol

General  Fields

2013_Gaz_ua_national

About

Layer containing sampling points:

Layers with fields/bands to get values from:

2013 Gaz_ua_national
2013_Gaz_ua_national
2013_Gaz_ua_national
2013_Gaz_ua_national

Shortest path

2012_Gaz_ua_national :
2013_Gaz_ua_national :
2013_Gaz_ua_national :

GEOID (source point)

NAME (source point)
UATYPE (source point)

: ALAND (source point)

: AWATER (source point)

: ALAND_SQMI (source point)
: AWATER_SQMI (source point)

2013_Gaz_ua_national : INTPTLAT (source point)
2013 Gaz_ua_national : INTPTLONG (source point)

ius.tmax_nchads Il 20140525 float : Band 1 (raster)

Cutput point vector layer:

9 Criterion
= [Esfsar ho

Browse

Length ||

Add created layer to the TOC

Time

Caloulate —

Complete the input fiells and press OK...

¥ shortestpath  Browser

Tl -

0]

¥ coordinate: |

-131.36,48.98

Dersc:ass @

| scale [517,776,445 ] Rotaton: [0.0 Render

Select “EPSG:4326” in CRS and click on “OK”.

0 £ Coordinate Reference System Selector ? x B Bl = - rl-|: | %Y
1| Specify CRS for layer firstout
Vi Fiter |
[+]
:.l Recently used coordinate reference systems
@D Coordinste Reference System Authority 1D "
o] 05GB 1936 / British National Grid EPSG:27700
/;'5 Morth_America_Albers_Equal_Area_Conic EPSG:102008
l Tokyo / UTM zane 54N EP5G:3095 0 op E&PO °
ﬁ% WGS 84/ Pseudo Mercatar EPSG:3857 b6 oo o2 ©
World_Azimuthal_Equidistant EPSG:54032 s o 00 0gRp0 o
q, WGS 84 EPSG:4326 LIk %6 %CD
GEJ Shortest path = > B owe®
1 =}
Start Coordinate reference systems of the world [ Hide deprecated CRSs § ©
Q,
5
I: Coordinate Reference System Autherity 1D ~ |je0d
Sy Voirol 1879 (Paris) EPSG:4821 ® Lo
WGS 66 EPSG:4760 ®®
- WGS 72 EPSG:4322 o
eEren WGS 72BE EPSGi4324
Length WGS 84 EP5G:4326 %
. v
tme [ | || (e VET2 IGNFWGS72G N NS
] (=]
Calalat= | | selected CRS: [wes 84 |
AL
— 4projlonglat +datum=1GS84 +no_defs | ®
2 aP
‘&
o Cancel Help
o
v Shortestpath  Browser [sa2ecd
| coordinate: | -131.36,48.98 | scale [:17,776,445 ~| Rotaton: |0.0

5|Pzgge
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# QGI52.8.1-Wien - X
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

D L A0S pHPPODRIGR f- %
e e [ o bg ‘abel abdl || [csw ﬁl) g
B (L5 8| O (%
Layers & X
Vigwvya@n o
:'.g @ firstout
(ﬂ [ @ 2013_Gaz_ua_national
a

us.tmax_nohads_ll_20140525_float

Shortest path & x

NAME Helena, MT Urban Cluster
25.02753

ol | [ Helena, MT Urban Cluster
@ (Derived)

= (Actions)
'\‘,B ‘ | 4 GEOID 38161

[+]

Criterion Length - us.tmax_no

9
§7° . Length [ |
1

Time [ |
Calalate Export Clear
&7 Help Mode |Current layer [] Auto open form
& .
v 4 Hel
9:-] P
&
b
¥ Shortestpath  Browser Bg

No features at this position found.

H o Type here to search ul

Yes our output layer is ready. Now select “Identify feature” tool and click on
any point from output layer and after that deselect output layer and try clicking
on same area in raster layer you will get similar results.

-111.60,%6.44 | scale [:17,776,445 ~| Rotaton: |0.0 +|FARender @Epsciazs @

# QGI52.8.1-Wien - X
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

™ 3 Mm@ o 6 FADD) ) O ~ = — . »
U A U P L 500 g e s EBE= i~ @ %
e = [y T W R wE @ | [
B (1% V& ﬁ&'
Vo Layers & X
olg wT@E3E 0
:'.g [] @ firstout
(ﬂ [ @ 2013_Gaz_ua_national
= us.tmax_nohads_ll_20140525_float
Ve
» £
°
2 A @M@ E % |
) Shortest path 8 x “
stort Feature Velue
" v fistout
[ | [ ~ [NAME Helena, MT Urban Cluster
@ (Derived)
"= | Stop (Actions)
& [ | [ GEOD 38161
NAME Helena, MT Urban Cluster
90 Criterion Length - us.tmax_ne  25.02763
470 | Lengh [ |
g | Tme [ |
o
Calauiate Export Clear
52 ke Mode | Current layer - [ Auto open form
- Help
¥ Shortestpath  Browser
No features at this position found. ¥ coordinate: | -113.27,36.77 | scale [:17,776,445 | Rotaton: 0.0 [ Render D EPsG:a326 @

H O Type here to search

6.|Pgge
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Now for polygon. Add “tl_2013 us_county.shp” file
Layer > Add Layer > Add Vector Layer...

£ QGIS 2.8.1-Wien - X
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
- @l

™ E Create Layer » [ﬁ D {; jeFeR- 1H : §

— Add Layer * L, Addvector Layer... Ctrl4shift+v I

Embed Layers and Groups... B AddRaster Layer... Ctri+5hift+R
B (R Add from Layer Defirition Fie. .

Add PostGIS Layers. .. Cirl+Shift+D
Add SpatiaLite Layer... Cr+shift+L
B Add MSSQL Spatial Layer... Cirl+shift+1
), Add Oracle Spatial Layer... Cirl4shift+0
Add WMSANMTS Layer. Cirl+Shift+W
Add Orade GeoRaster Layer. .

Add WES Layer..

Add WFS Layer...

Layers Copy style
s 9 Paste style

Open Attribute Table

Toggle Editing

Oe
O

Save Layer Edits

Current Edits

Save As s Add Delimited Text Layer...

Va
"
%
4
»
Q, Save As Layer Definition File...
)
G%
Vd
%o
Va
&

Shortest path Remove Layer/Group Ctri4

Start Duplicate Layer(s)

Set Scale Visbility of Layer(s)

Stop Set CRS of Layer(s) Cirl4shift+C

| Set Project CRS from Layer

Properties..

Criterion
Query... Crl+F

L e[ Labeling
& Time oo

T Add to Overview
Calalate oo

Add All to Overview

=5 ©2  Remove All from Overview

Show Al Layers Cirl+shift+U
Hide All Layers Cirl4shift+H
Show Selected Layers

Hide Selected Layers

¥ Shortest path T BIOWSEr ]

¥ coordinate: | -130.12,53.05 | scale [:17,776,445 | Rotaton: 0.0 [ Render D EPsG:a326 @

ﬂ O Type here to search i) i . ® 3 v @ m . ]

Browse “tl_2013_us_county.shp” file and click on “Open”.

#

EE gﬁ' Fil LvD‘L@?

B IR '8 | (56 %

Layers & x
= T @ @ [
[J © firstout

2013 Gaz ua national
us.tmax_nohads_l_20140525_float

/ Add vector layer
Shortest path 8 x
Source type
Start
@ Fle (O Directory (O Database () Protocel
‘ | + Encoding |UTF-8
Stop
‘ | < Source
Criterion Length - Dataset hrvasva\QGIS\Bipi_2013 us_countyli_2013 us_county.shp | [ Browse
§7° . tenatn [ ]
Open Cancel Help
g | Tme [ |
I}
Calalate Export Clear
3 Hep
v Shortestpath ~ Browser

8| coordinate: | -130.12,53.05 | scale [:17,776,445 | Rotation: ‘U‘U 2| A Render GiEPsciasze @

Now the problem is that the file is in different CRS we have to save the file in
“ERSG:4326" CRS.-Right elickionjlayer and select-“Save As:. =

7|Pgge
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# QGI52.8.1-Wien

Project Edit View Layer Setfings Plugins Vector Raster Database Web Processng  Help

DB 8

B (R 0 [ (%

Layers RS

. P (=) 9 B9 )
Sl 2 MHPDLDLALES

o A 8

&

& EE’I'

Vilsawvao
i

us.tmax_nohads_ll_20140525_flo: "~
a [ @ firstout

/73 [0 © 2013_Gaz_ua_national

Shortest path

Start

Stop
Criterion Length
. length
Time [
Caloulate Export Clear
53Hep
¥ Shortestpath  Browser

Toggles the editing state of the curent layer

H O Type here to search

Give path and name to file and set “EPSG:4326” in CRS.

il
Zoom to Layer
Show in overview

Remove

Duplicate
Set Layer Scale Visibility

Set Layer CRS
Set Project CRS from Layer
Styles ,

Open Attribute Table
Toggle Editing

Save As...
Save As Layer Definition File.
Filter...

Show Feature Count

Propetties

Rename

%5 coordinate: |

-131.87,53.92

-~
| scale [:17,703,236 | Rotation: [0.0 | Arender @ ersciazecr @

Check “Add saved file to map” checkbox and click on “OK”.

£ Save vector layer as...

abel sy Format |ESRIShapefile

Save a5 [ExfSarvasva/QGIS/8/bjoutput/countryout.sho

Browse

B IR '8 | (56 %

Layers

CRS  Project CRS (EPSG:4325 - WGS 84)

@ =T @@

o D,@

Encoding

] 8 2013 us county
us.tmax_nohads_ll_20140525_float
[J @ firstout

[ @ 2013_Gaz_ua_national

[ skip attribute creation
Add saved file to map

Symbology export

Shortest path & x
Start
Stop
Criterion Length -
Length |
Time: |
Calauiate Export Clear
3 Hep
\P
\Z
¥ Shortestpath | Browser

Toggles the editing state of the curent layer

8lPage

P [ Extent (current: layer)

¥ Datasource Options

¥ Layer Options

P Custom Options

UTF-8

No symbology

Cancel Help

- -

& coordinate:

-131.87,53.92

| scale [:17,703,206 | Rotation: ‘U.U

Render €D EPSG4326 (OTF) @
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# QGI52.8.1-Wien - X
Project Edit View Layer Settings Plugins Vector Raster Datsbase \eb Progessing Help
S - Y

DEBRER A2, HPL ARG G-
4 . 9 g g e g wm | oo A £
B (R 0 [ (%

Layers 8 X

@ = v 3@
|

[ t_2013_us_county

B us.tmax_nohads_ll_20140525_float

O © firstout

[J @ 2013 Gaz_ua_national

Shortest path 8 x
H
Start

Vo
"
e,
4
»
®
-]

\ | B
] ..
& || | B
9 Criterion Length -
o =Tr
§7° . Length [ | =
o | Tme [ |
')
Calaulate Export. Clear
—:1:— 5 o Hep
2
]
&
o
v Shortestpath  Browser o
Toggles the editing state of the current layer %5 coordinate: | -109.42,43.31 | scale [:17,703,236 | Rotation: [0.0 | Arender @ ersciazecr @

: 2 X 12
ﬂ QO Type here to search i . £ A& ED) gpang M

Once new layer is loaded go to

Raster > Zonal statistics > Zonal statistics

£ QGIS 2.8.1-Wien - X
Project Edit View Layer Settngs Plugins  Vector | Raster Database Web Processing  Help
T~ D 32

j 4 & @ :;35 e;’; Raster Calaulator... {ef/\]\ ( (.:'

. el » \‘ =
2
4 Heatmap »
B IR i, % Interpolation » ‘
Layers : @ Terain Analysis 4

= T @@ Zonal statistics » ¥ zond statistics

Projections

»
¥ us.tmax_nohads_ll_30140525_float Conversion Y
[ @ firstout Extraction »
[J © 2013 Gaz_ua_national Analysis »

»

Miscellaneous

Va
¥
mo
4
q Shortest path d GdalTools Settings..
@ || |
&
Yo
%
Ve
: &

Stop
\ | BE SEacs!

Criterion Length -

Length | |

v Tme | |

Calalate Export Clear

S S Hep

M Shortestpath  Browser —

%5 coordinate: | -129.40,55.30 | scale [:17,703,236 | Rotation: [0.0 2| Arender @ ersciasze o) @

: 2 X 12
ﬂ QO Type here to search i . Hias @) jopame

By default it will fill all data. Here “zonalstate” will be prefix for the columns
which will be created.

9|Pgg.e
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i} ' 3
+
L N

Tl -

H_2013_us_county
us.tmax_nohads_ll_20140525_float

»
Q, Shortest path & x
®

/ Zonal Statistics

Raster layer:
us.tmax_nohads_Il_20140525_float

Start Polygon layer containing the zones:
| [ countryout
Stop Output column prefix:
| [ [zonatstate]
Criterion Length -
Length | |
Time [ |
Calauiate Export Clear
54 Help
¥ Shortestpath  Browser —
| coordinate: -129.40,55.30 | scale [:17,703,206 | Rotaton: ‘n.n = Render D EPsG:4326 (OTF) @
Click'on “OK”
L]
&
ﬂ c s @ o ) F9 D Q) E'—‘. < 1
1 NP Nl el Rl A @& = - Hl %
y g e [y g kel <abe e Gbd | fcow ﬁl) g
B (L5 8| O (%
Layers 8 X
3 ow T E G L
7] countryout
[ ] t_2013_us_county
¥ us.tmax_nohads_ll_20140525_float
O © firstout
[J @ 2013 Gaz_ua_national
# qgis-bin ? bod
x
=i = Calculating zonal statistics...
Start i
Ic: 7%
stop
\ | [
Criterion Length -
Length | | Ty
Time [ |
Caleuiate Export Clear
| 5 Heb
—
A .
e}
o
o
AVZ]
¥ Shortestpath  Brawser -
%5 coordinate: | -101.65,33.58 | scdle [:17,703,296 ~] Rotation: [0.0 2| Arender @ ersciasze o) @

H o Type here to search ul
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# QGI52.8.1-Wien - X
Project Edit View Layer Settings Plugins Vector Raster Datsbase \eb Progessing Help

m™ == IgelEN ( b A
DEBRLE 0% 5
¥ ) o /% < =

B (L5 | O (%
Layers X
0 =FTEE LD

B countryout

[ ] 1_2013_us_county

B us.tmax_nohads_Il_20140525_float

0 @ firstout
[] @ 2013 Gaz_ua_national

LPAPRPLALARGE M- LEBE=-O g I-/BY%

g, ol G| fesw ,“.I> Q

NSNS

3@ @
@, [shortest path 5 x Ve
=i csaFp NULL
[~ R CBSAFP NULL
METDIVFP  NULL
[ | [+ FUNCSTAT A
— ALAND 20454562405
@ AWATER, 172002709
= || | [ INTPTLAT  +41.7035304
A INTPTLON  -106.9331526
<6 | criterion Length hé zcount 6.000000000000000
| I — | | 2sum 108.387364387512207
2 < - zmean 18.064560731252033
W o Time [ | NAME Natrona v
5 & Calailate Export Clear Mode | Currentlayer - [] Auto open form
5d .
‘ $2hep view [Tree Hep
—
8:
]
&
L}
¥ Shortestpath  Browser —

% coordnate: | -121.84,44.91 | scale [:17,703,206 | Rotaton: ‘n.n :|Render O escan o) @

Once the operation is done click on identifier tool and select feature from layer.
It will display the results.

/4 QGIS2.8.1-Wien = X
Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help
M BRI & E P HBTADDOD Q ~ 0. = — - =
D=8 R U AVS 2L PO AL & N-GeEE= 0 - [l %
/ 3 R /3 > & (o ) | o w ,‘l) g
(T (0w N
B [F 5| 5 (%
Layers & x
O % PEEGQ
& Bl countryout” T S ZoomtoLayer
[0 ] 4_2013_us_county :
¥ us.tmax_nohads_Il_2014: Show in overview
[J o firstout 4 Remove
[0 © 2013 Gaz_ua_national | | Duplicate

| Set Layer Scale Visibility
Shortest path Set Layer CRS

DB DINSNES

Start Set Project CRS from Layer

— Styles »
g | L |

Stop S Open Attribute Table

[/ Togglekdiing

Criterion Length Save As...

Length Save As Layer Definition File...

Filter...

i G ﬁu\a :ﬁ (cﬁa

i 1 |
Calaate Export :
Properties
033
oo Help Rename
— —
&
6
\P
v | Shortestpath Browser -
Toggles the editing state of the current layer & coordnate: | -132.01,51.67 Scdle [117,703,296 | Rotation: [0.0 t|Drender @ersciassom @
. 12:33
O Type here to search o L A@zD [l

10-03-2019

Now-we can.also style this.output, for,that go to Layer’s properties.

In style panel select “Graduated”, in Column select “zmean”, select
“Quantile(Equal Count)” in mode, in select one ramp and click on “classify”.

Click-on-“OK”.
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™ SN= R £
L !’5 5| ¥ Layer Properties - countryout | Style

o Graduated -

[

«| g U L 6 1

m
—_—
Layers Symbel roe... Classes [5 B
- )
= T @ @ Color ramp I ourcel T Mode| | Quantile (Equal Count)

[ countryout Legend Formatl—aes=os: - | precision [1 | O
O[] 1_2013_us_county -
B us tman_ nohads I Symbol Values Legend
0.000-24.762 0.0-24.8

0 @ firstout

24.762-26.593 24.8-26.6
26.593-27.635 26.6-27.6
27.635-29.660 27.6-29.7
29,660 - 37.003 29.7-37.0

Column

@, [shortest path (J(a Actions

& ser 4 soins
[ 0

|IER piagrams

EEECC

Calaulate

Export

Add dlass Delet= Delete al Link class boundaries Advanced ¥

¥ Layer rendering

Layer wransparency 1

Feature blending mode Normal -

54 Help

.

Layer blending mode Hormal

Style ¥ oK Cancel Apoly Help

- -

Render D EPsG:4326 (OTF) @

shortestpath  Browser

Toggles the editing stte of the current layer | Coordinate: -132.01,51.67 | scale [:17,703,206 | Rotaton: ‘n.n

Yes our output is here.

# QGIS2.8.1-Wien - X
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

— ~ = f— : T| v
L ~ ok B = % !
w
Vo
= =3
@, shortestpath 8 x z
Start
&R [ +
Stop I g
[ |
Criterion Length - R
Length ] =20 F
'S
Time | | &
2 Calaiate Export Clear
5 Help .
.
v Shortestpath  Browser
Toggles the editing state of the current layer & coordinate: | -95.84,48.54 Scale [:17,703,206 | Rotation: [0.0 2| Arender @ epsciaszs o) @

= 12:36
£ A@ D 10-03-2019 |

ﬂ O Type here to search
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